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1 Introduction

This getting started manual and reference guide is intended for the end-user. It is assumed
that the user has a basic knowledge on how to use Microsoft Windows® applications in general
and that he or she is familiar with the terms used and work done in tool rooms in particular.
This is not a TMS software installation manual. To install TMS use the TMS setup and database
implementation documents or contact Object Software Ontwikkeling BV.

1.1 Purpose of this document

This document consists of two parts. The first — getting started - part describes in short the
‘theory’ and ideas behind the Tool Management System. Why is data structured as it is within
TMS and what do the terms used within TMS mean.

The second - quick reference - part tries to provide ‘how to’ information to use alongside the
Tool Management System.

1.2 Conventions and terms used in this document

Specific term used in TMS - Italic. Example: Cluster.

Reference to a literal or a text on screen - bold. Example: EmployeelD.
Reference to a Windows button - bold between []. Example [Cancel].
Reference to a keyboard combination — bold between {}. Example {Alt X}.

Chapter Introduction page 3/22
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2 TMS definitions and methods

For the daily practice of a department that lends and distributes tools by means of barcode
readers the tool management system uses certain methods and terms. In this chapter these
key terms are explained.

2.1 Common tables

An administrative system such as TMS often requires data that is indirectly related to the job
at hand. This data must be available in the system and it often has a certain hierarchy.

For instance: a tool is lent to a person and this person belongs to a department. Because we
don’t want to enter the entire department description each time we add a new employee to the
system a table of departments is put together. This table also provides consistency in the
description and allows proper grouping of data in reports and screens. But deleting a
department from this table implies that all employees that are part of this department must
also be deleted or must be assigned to another department.

In such a case TMS will either not allow the deletion or reassign the related data to a different
record in the departments table.

Common tables can be entered and edited within TMS under the Edit menu. There are
currently six common tables in TMS:
Departments: a register of departments.

Functions: a list of personnel functions.

Employees: a register of all persons (or perhaps a workgroup) that might lend
something.

Suppliers: List of suppliers of tools.

Products: a catalogue of products that might by used.

Product groups: divides products into groups.

The relationship between the data determines the order in which each table must be filled (the
order in the Edit menu is alphabetic). For example: an employee belongs to a department and
not the other way round therefore the department must be entered before the employee is
entered.

This kind of data always consists of a unique ID and other relevant data. E.g. there can only be
one department with ID ‘001’ but several departments can have the same description (not
clever though).

There is an ‘Undefined’ record with ID ‘P’ available in all tables that can be selected when for
instance the department of an employee is not known. It is however recommended that you
collect and enter data at the top of the hierarchy first (as much as possible) before you start
entering data more down the line. It is much more work when you have to reassign products
to new product groups or employees to new departments later on when you find that you
cannot print properly grouped reports.

ADVICE: Collect and enter data at the top of the hierarchy first and as much as possible
before you start entering data that relies on other tables.

2.2 Products and Items

TMS uses two terms that relate to tools; product and item. Both represent a tool in a different
way:

Product A product in TMS is a description and definition of a type of tool. The products
table can be regarded as a catalogue of tools; you may not have any tangible
item of a tool but you can have it described in the product list. For each type
of tool there should only be one product representing its properties. There is
no need to enter the same product more than once to get multiple serial
numbers for instance. You should enter a product record for each type of
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chisel you have on stock (chisel 10mm, chisel 20mm etc...) but not for the
fact that you have 10 pieces of chisels of 10mm.

Item An jtem in TMS is physical, tangible, representation of a product. If you have
10 pieces of chisel 10mm you have 10 items of 1 Product ‘chisel 10mm’. If
you have zero (0) items of chisel 10mm you still have 1 Product ‘chisel 10mm’
and TMS can alert you that this product has gone below stock and that you
should buy chisels 10mm.

If you want to add a tool to TMS that has not been defined before then formally you should:
e First enter a new description of that tool in Product
e Then add new items to the stock.

However, to simplify matters TMS allows you to enter a new product and add a number of
items to the stock in one go (in the ‘add to stock’ screen). In this way you can gradually build
the product list and stock as you work with TMS.

2.3 Serialized and non-serialized items

TMS can handle both serialized and non-serialized tools. At the Product level you define
whether a tool is a serialized tool or not.

Non Serialized For this kind of tool it is only important to know how many you have on stock
and who has lend the items. Items cannot be traced individually. Non
serialized products are for example small hammers, screwdrivers or
sandpaper. You want to know how many you have and who has them but
these items don't have to be calibrated or recalled for a safety inspection.
Non serialized items only contain the product code and an amount in TMS; if
there are zero (0) items of a product the product is not shown at all.

Serialized With serialized tools you can keep track of each jitem individually. You can see
exactly which item has been lent by whom and know when an item has had
regular maintenance or has been calibrated (TMS check and inspection
options). If the tool is serialized then each item must get a company number
and optionally a serial number. The serial number field is intended for the
manufacturers’ serial number and is not required. The company number is
either a unique code for the product or a unique code throughout the system
(globally unique). This company code is required for serialized tools. The
company number can be derived from the serial number or it contains a
completely different code given by the company (hence the term company
number). The company number is restricted to characters that can be printed
on a Code 39 barcode (A..Z, 0..9) up to 20 characters long but the
manufacturers’ serial number can contain all characters and may even be left
empty. Non unique company codes are shown in grey within TMS; unique
company codes are black. If a company code is unique then the barcode label
will only contain the company code. If it is not unique the barcode label will
have both the product code and company code printed on it because the
productcode cannot be derived from the company number. So there are 2
kinds of company numbers:

Product code Company number
Non unique 123 - Drill 250W Esso.1

123 - Drill 250W Esso.2

234 - Drill 500W Esso.1

234 - Drill 500W Esso.2
Unique 345 - Harness 500Kg E93746

345 - Harness 500Kg E37467

456 - Harness 1000Kg E74678

Of course for each item with a company number the amount is one (1).

Chapter TMS definitions and methods page 5/22
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ADVICE: Use unique company numbers where possible. TMS can better ascertain the owner
and your barcode labels will be shorter.
Use company numbers for tools that exceed a certain value (f.i. more than € 100,-)

2.4 Clusters

A cluster is a special kind of tool that can contain other tools. For example: a toolbox or tool
set. Clusters are always serialized and can contain both non serialized and serialized tools. If
you lend or issue a cluster all tools within that cluster are lend or issued as well. A cluster can
also have an end date that differs from the lend term. This end date can be used to assemble
a cluster for a project and then lend or issue it to a person or workgroup. A report with expired
cluster end dates reminds you which projects have finished and which clusters should be
recalled.

ADVICE: The add-in CopyCluster enables you to quickly create several identical clusters
containing non-serialized items (e.g. for toolboxes).

2.5 Operational and non-operational items

The Tool Management System distinguishes between items that are operational and those that
are - perhaps temporary - not available for operation. Operational items are shown in the
stock and lend screens. Non-operational items are shown in the issued items and non-
operation items screens. The reasons for unavailability can be:

e Issued; the item is hand out and not expected to be returned.
Damaged; the item cannot be used because it is damaged.
Missing; the item is lost.
Inspection; the item is being inspected or recalled for inspection.
Repair; the item is being repaired.
Discarded; the item is no longer being used (administrative write-off.

The Issued items screen is displayed by clicking the [Issued items] button in the toolbar or
selecting the Manage->Issued items menu. All other non operational items can be viewed via
the Manage>non operational items menu. Of course an item can first be indicated as
damaged, then moved to Repair and finally be activated again so it can be lend again (Return
item to stock).

2.6 Item inspections and checks

Within TMS there are two methods to follow up tools that periodically must be inspected or
checked. The two ways have a different implementation that can be used simultaneously; one
method does not rule out the other but they just fulfil different needs.

Inspection When an item is moved to inspection it is taken away from the operational
items just like the actions damage or missing do. These items are probably
inspected by a person from a certification organization or send to a different
location (in house or 3™ party) to be calibrated, inspected or maintained.
Therefore, such items must be held back and not lend until inspection has
taken place. When this inspection has been done and the item is approved
you can add comments to the inspected item line and use the [Return to
stock] button to return the item to the operational items again. When the
item was part of a cluster you can return it directly to the cluster or when it
was issued (lent for an undefined period of time) directly to the ‘issued to’
employee. When the item is returned, the ‘last inspected date’ is set to the
current date. A report of inspected items within a given time frame tell you on
which items inspections have taken place (item history reports). In the
product definition (Edit2>Products) you can set the inspection interval in
days. TMS uses this number of days, along with the deployment- or last

Chapter TMS definitions and methods page 6/22
© 1999...2005 Object Software Ontwikkeling BV Version 12/4/2005 rev.53



TMS getting started and quick reference guide

inspected date in the items to be inspected report to show you which items
must be recalled for inspection.

Checks For a lot of quick checks the inspection method is a too heavy method. To
register (and show to an auditor or inspector) that you also perform
intermediate checks can use the checks method. Per item you can maintain a
list of checks that consists of check date/time, comments and an indication
whether the check was okay or not. But you could also use the checks
mechanism to register for example that a stock count of these tools has taken
place. Similar to the inspection method you can enter the check interval in the
product definition. The report items to be checked will show you which items
should be checked within the given number of days and when the check date
is overdue. The report item checks under the Reports—>Item actuals menu
will show you all the checks done in a given time frame.

2.7 Issued items

Issued items are items that are not lend but are handed out while not expected to be returned.
For example items like sandpaper (consumables), safety shoes or helmets. With the issue
function you can keep track of your stock and handle these items with the barcode reader in
the same way as you would lend items.

Another application of the issue function is to lend items to a person for an indefinite period of
time. All lend items have a lend time (as set in TMS through File>Configuration, General,
lend time) and when this time has expired it will show on the Lend items report.

If you, for instance, want each technician to get his own toolbox when he starts working and
that must be returned when he is not employed anymore then you can issue the items to that
technician. Those items won’t show on the lending reports but you still have registered the
tools he has gotten on his first working day and during his career. This is why clusters and
serialized items can also be issued. TMS will recall clusters with an enddate and serialized
items for inspection/check also from the issued items bin.

2.8 TMS itembag

TMS uses handheld barcode readers that run its own TMS data collection program. With 128Kb
of memory it can collect about a 1000 transactions. All lends and returns (transactions) via
barcode readers take place off-line with no wire limitation or need for RF equipment.
Transactions are only transferred to TMS when you place the reader in the communications
cradle and order TMS to get the data from the reader. Because multiple barcode readers can
be used simultaneously a tool can be lend on reader A but be returned on reader B. Therefore,
if more than one reader is being used, all transactions from all barcode readers must be
transferred to TMS first before processing them. All the transactions are stored in the itembag
and when processed they are treated as one virtual barcode reader and processed in date en
time order.

Because the barcode readers work off-line they are not aware of the actual status of items that
are scanned. So it might be that 2 barcode readers both lend four 10mm screwdrivers (8 in
total) while there are only 5 registered on stock. During transfer (from barcode reader to
TMS), product- employee- and company codes are validated and automatically corrected if
possible. When the itembag processing takes place, it is checked that a transaction is valid and
possible. If that is not the case, it will not be processed but appear in the itembag error
section. The itembag processing error section will show you the nature of the problem and
allow you to search for solutions and correct the problem or discard the transaction entirely.
The TMS database is only then up to date when all itembag transactions including errors have
been processed or cleared.

ADVICE: Instruct the people that work with the barcode readers thoroughly on how to use
the readers correctly. It will spare you a lot of itembag errors!
Get your toolroom ‘watertight’; do not allow tools to slip out or into the toolroom
without being scanned. Discrepancies between reality and a management system
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like TMS will always occur but will quickly get unacceptable if not all tools are
scanned.

2.9 TMSlog

All the actions on tools are registered in the TMS log. When you add, lend, issue, inspect,
damage (...) items it will be logged. The logging occurs after the event has taken place; i.e.
when you lend an item it will enter the log when the item is returned. Only then it has become
history. Most TMS screens will show the actual status of the system. If you want to look at the
history of an item, select the history button or right-click on an item and select history. In the
reports menu a menu section item history allows you to select history reports.

2.10 Barcodes

There are many barcode types in use in various applications. There are 1 and 2 dimensional
barcodes, codes with build in checksum and predefined application codes. Widely used types
are: Code 3 of 9 (also called Code 39), Code 128, Code 2 of 5, EAN13 and EAN128. Code 39 is
reliable and effective and not subject to a committee validating the codes you create and it can
be read by every barcode reader for sale. Therefore code 39 has been chosen as the basis
barcode within TMS. Other barcode type can be used (dependent on your label printer) but
checks of the validity of the codes and IDs are always against the Code 39 character set. This
set consists of capital A to Z, numbers 0 to 9 and characters % + - . /. The $ sign is also a
valid Code 39 character but has been reserved by TMS to mark unique company numbers
within the barcode (so the reader can act accordingly). There are 4 kinds of barcode labels that
can be printed with TMS:

e Employee label; this contains the EmployeeID as a barcode and the name of the
employee.

e Product label; Contains only the ProductCode as barcode and the product description
when printed from the Productlist or from any of the itemlists (stock, lending
overview, ...) when it is a non-serialized item.

e Non unique serialized item label; contains both the ProductCode and the
CompanyNumber as barcodes and the product description of the tool.

e Unique serialized item label; contains only the CompanyNumber as barcode and the
product description of the tool.

Optionally the storage location can be printed on all item labels as well.
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3 Quick reference guide

This part does not provide detailed information on every screen of TMS but focuses on how to
accomplish specific tasks within TMS.

3.1 Quick explanation of TMS controls

3.1.1 Common program controls

IV Preview  check box; activate option by checking the box.

Selection
' Today
0 Thiz week
£~ Thiz month

Radio buttons; only one of the options is selectable.

| [k nioan] ﬂ

Animals —| Combo box; pick a value from a list.
Chair —
Companiohz Opera

Costumes

Dance & Ballet

Drirection

Diivers -

M 4]10f133 Illﬂl Record navigator; browse through records.

E ' - | . .
v [Insert Edi | [V Select 45 + &% Dokl 755har activate functions.

| Barcode . . .
l I Tabbed screen; screen has been split up in several sections

Code: |01 Greyed textbox; textbox that cannot be edited.

Code: Jverpichte imvoed | o0, textbox; data entry is required.

3.1.2 Reports

In any IT system there are reports that show the current state of the system or summarize the
results. All reports can be started from the Reports menu but sometimes they are shown
when the [5] button is clicked in stead of a print screen. All reports are first previewed on

screen and can be printed or exported using the report . .
@ Zoom |100% -

toolbar. You can also enlarge or reduce its size on screen
by using the Zoom combobox (this doesn't affect the
printout on paper).
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3.1.3 Listviews

TMS uses a lot of lists to show and control data. Most of these lists can be manipulated in a
similar way.

1)

Surname \1 Firstnarne | Gender | b obilePhone | etd ail »
[ &lbayrak Taylan | 0174/3559279 taylanalb:
O 2lbrecht Sebazhan k 173-2135474
O 2nzorge b arian F M72-6741805 MAAramn. am
Wlintlin ] F 1702851295
O trens Klaus k klaus. aret
O 2ing Heinrich b heinrich.a
O &mould Eernard t
O &rslanlar Tugnil b phok aitay
[ B akker ¥vonne F
[ Eannefeld Alina F 1620604123 anilabad0
[ Eannefeld b artina F 1627460277 arilabal0
O Bazzner Lathar k
O Bauch Jennifer F 1743682554 6198 4red
O Bauk Agnes F 0163 BE2E295 agnezha. 3
< b3

The listview element always has the following properties:

1. The columnwidth can controlled by dragging the column separator in the list heading® to
the left or the right. By using the key combination {control +3} TMS will automatically set
the columnwidth of each column based on its contents (the control must be the active
control for this to work). {control *3} sets the column width to fit either its contents or the
text of the columnheader (whichever is widest). TMS stores the columnwidths for each
screen per user in order to restore these same settings when the screen is opened a next
time.

2. You can search for a specific row in the list based on the information in the first column.
Activate the list (left mouse click in the list) and type in the (first few) characters you
search for. The more characters you enter, the closer you get to the data you look for. The
typing of characters must be done rather quickly (within 2 seconds for each character)
otherwise the search function will presume you search for a new value.

3. The sort order of the list can be changed by clicking on the column header. A 2™ click on
the same column header will reverse the sort order of that column. The altered sort order
is always temporary and will not be stored.

4. The {F5} key will refresh the list.

5. When the listview contains checkboxes ([ in front of each row) you can select and
unselect rows by clicking on each checkbox. A range of rows can be selected in
combination with the {shift} key. Select the first row, hold down {shift} and select the
last row you want to select. All rows between the first and last row will be checked. In most
cases there will also be toolbar buttons to select and unselect all rows or reverse selection.

3.1.4 Window menu

The window menus offer standard facilities such as Tile Horizontally, Tile Vertically,
Cascade and Arrange Icons. Additionally there is the AutoArrange menu option that neatly
Arranges the main window, icons, window sizes and positions when your TMS screen is a
mess. The Close All option quickly closes all open windows of TMS.

3.1.5 Help~>Support>e-mail Support Request

This menu opens an e-mail in your e-mail program addressed to support@objectso.nl with
additional technical information about your system. You can add/edit your question or problem
and send it.
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3.2 Employee actions

3.2.1 Add an employee

From the Edit menu select Employees. Click [Insert] on the employee overview toolbar.
Enter an employee code (Yellow: required). This code is limited to the barcode code 3 of 9
character set and can be up to 10 characters in length. Numeric codes are padded with zeroes
on the left up to the number of positions as set by your TMS administrator (default = 6). For
example: when you enter code 123 it will be converted to 000123.

ADVICE: It is recommended that you use numeric IDs in stead of alphanumeric IDs. Numbers
can be entered into the barcode reader a lot more easy than alphanumeric
characters.

3.2.2 Delete or deactivate an employee

Select an employee in the Employee overview and click [delete] in the toolbar. When an
employee has never gotten any items you can delete the Employee by clicking on [OK]. If the
employee has a history (i.e. has gotten items) then you can only deactivate the ID. When an
EmployeelD is deactivated it will no longer appear in the lending and issued items overviews
and reports unless the Employee still has items.

3.2.3 Renumber/rename an employee

Select an employee in the Employee overview and click [edit] in the toolbar. Select the [#]
button on the right of the EmployeelD. Enter a new ID in the field New EmployeelID and click
[OK]. Note that you cannot rename an ID to a number or code that already exists.
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3.3 Add a new tool

3.3.1 Using an existing product definition

From the Edit menu choose Add items to - y
stock or click the [Add] button on the
Stock overview screen. The Add items to 1. Search for product

stock screen will appear (see screenshot). | iporseacheods contains: | Clear
Tools can only be added to the stock and

never directly to a cluster or person. To add

2. Select product [3587 found)

. . . In] | D escription | Searchcodel |A
an item you follow four steps as indicated INEW]  [dauble click to 2dd 2 new product]
by the 1 2 3 4 headers in the dialog. 80000003  BoorMetaal 0.5 Mm. tirfar
80000008 BoorMetaal- 1 Mm. Bioor Metaal
H 80000003 Boor Metaal 1.1 Mm. Boor Metaal-
1. Type_ln_ (a part Of) the prOdUCtCOde or 80000010 BoorMetaal- 1.2 Mm. Boor Metaal-
description of the tool you look for. 80000011 Boor Metaak 1.3 Mm. Boor Metaal
: = 0000012 BoorMetaal- 1.4 Mm. Boor Metaal-
When you click on [find] or press 80000013 Boor Metaal 1,5 Wm. Boor Metaal
{enter} the productlist under (2) will gggggg}g gom.metaa:- }gmm goor.metaa:-

. taal . oor Metaal-
show you the items that match your S0000017  Boor Metask 1.3 Mm. Boor Metaal
search. JF)| BO0O0018 BoorMetaal- 2 Mm. Boor Metaal-

- ?999991? Eoor,MeFaa!- 2.1 m. BoorMetaal
2. Select the product you want to add in < >
the productlist by clicking in the /istview. | 3.Enter item information
Dependent on the product being Serial rumer: |
serialized or not the field serial- and Company number: | [~ Unigue
company number are editable or not. Suppiier: | =
:I'his also appli_es to the nyn_1ber_ c_:f Siege st |
:’it::dwtotq add field. When serialized it is Number of tems ts s [T
) ltem price (per piece in €1 ,7000
3. Enter item details in the fields under |, ...
item information. When the product [ Prirt barcodelabel
selected is serialized you can enter the \/Addmmk
serial number, companynumber and -

unique fields otherwise you can edit the
number of items to add (between 1 and 30.000). If you enter the serial humber first and
the company number is empty TMS will convert the serial number into a valid Code 39
company number by replacing invalid characters with dots. Of course you can overwrite the
company with your own number or you may leave the serial nhumber field blank and only
enter a company number. In case of a serialized item you can select whether the serial
number must be unique or not. When checked TMS validates that the company number
entered is unique throughout the system. When unchecked the company number must be
unique within the product code. The storage location field enables you to register where the
item is located in your warehouse. For non-serialized items that are already on stock this
field is ignored. It is recommended that you enter an (estimated) item price because it will
give you an indication of the value of your stock and the tools people take with them but if
you don’t know or want to register the price set it to zero. If the product selected is a
cluster you can also enable and enter a cluster end date.

4. When you click on the [add to stock] the item will be added to the stock. If the item is
serialized or not yet on stock a new item line will be created, if the item is non-serialized
but already on stock the amount will be added to the current number of items on stock. A
new entry will be created in the log registering that x number of items have been added to
the stock. With the report Items added to stock in the Reports->Item history menu
you can review when, which and how many items have been added in a given period of
time. When you check the print barcodelabel checkbox a barcode label of the item
(containing product- or company code or both) will be printed if the item has successfully
been added to the stock.
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3.3.2 Using a new product definition

It might be that the product you look for is not in the product list. In that case you can either
add a new product in the products table first (Edit>Products, New) or double click on the
(NEW) line in the product list or click on
the vertical Select product caption. A [=

different part will slide in place of the | 1 Searchfor product

product list that allows you to enter a new | ID o seacheode cantains: [EEE Clear

product AND enter a new item. Step 2 has
now changed to enable you to enter new

2. Hew product

prOdUCt Specifications. ProductCode: l— [ Serialized [
1. This step works similar as described in SEZZ:ZZ:T:: 2
section 3.3.1. Click [find] or [clear] ' '
and the new product section (2) will be Pl By =
cancelled and the product list will appear Defaul Suppier. | El
again. Inspection interval l— 48 Distibution bype
. Check interval ,_days {+ Determine at barcode reader
2. In this step you can now enter a new . ™ Always lend [we wart it back)
inimum stock: |—5

7 Bhveays izzue [conzumable)] Cancel

product. The ProductCode field is _ -
limited to the Code 39 character set and Waranty months:
has a field length of 10. With the | 3. Enteritem information

serialized and cluster checkboxes you SR |

can set that the item is serialized or is a Company number. | r
cluster (always serialized). Description Supplier: | |
0bViOUS|y describes the tool (maX 100 Storage location: |

chars). Search code 1 and 2 (each up Wumber of temsto acet | 1
to 12 chars) are not displayed on TMS | .\ iceerpieceing: [ 000
screens but can be used to add extra
information to the product to find the ™ Print bareadalabel
product when you add new tools or in

the Edit>Find item(s) function of TMS. \/ (et e
The ProductGroup combobox allows
you to group tools together so they are easier to find in the Stock overview for instance.
Default supplier identifies the vendor that usually supplies this kind of tool. In step 3 this
default supplier is shown first but there you can deviate from the default when the item in
a particular case has been supplied by another vendor. The fields, inspection- and check
interval let you set a period of time between checks/inspections in days (up 3650 days or
10 years) or disable it for this product (when 0). The minimum stock field assigns a
minimum level of items you want on stock. The report Products to be ordered
(Report>Orderlist) uses this value to determine which products need to be ordered to
get to that minimum level. Set to zero this product won't show on the report (no minimum
level). The field Warranty months can be used in combination with the deployment date
each item gets (mainly useful for serialized items) to show if the item still has warranty or
not (currently unused feature). Distribution type determines how data processed from
the barcode reader will be handled. If set to Always lend (default for serialized items)
then TMS will always lend the tool even though on the barcode reader the function issue
item has been selected. Likewise when set to Always issue, all items processed by the
barcode reader will not be lend but issued. This option is recommended for consumables
like sandpaper for which you know up front that you will never lend it. When Determine at
barcode reader is selected the handling of barcode transactions is fully dependent on the
choices made on the barcode reader.

4. Finish

TIP: You can copy a product definition by selecting a similar product in the product list
and then click on the vertical sidebar. Only a new product code must be entered and
the description altered.

3. See description of step 3 under section 3.3.1
4. See description of step 4 under section 3.3.1
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3.4 Remove a tool

Tools (items) enter into service through the Add items to stock screen. An item can be
removed from service in several ways; it gets issued, missing, damaged or discarded. In the
first three cases the item gets non operational as a result of the event itself. With the Discard
option, available on several Manage screens, you manually remove the item from service. It
will be moved to the discarded section in the Non Operational Items screen and the history of
the item is preserved. After a while you can use the Delete history method (from the File
menu) to remove items and history older than a given time. If you want instantly want to
remove an item from TMS you can move it to the Non Operational Items (by using discard
for instance) and remove it permanently, including its history, by holding down the {control}
key in the Non Operational Items screen and click on the [Delete] button.

3.5 Remove historical data and non operational items

After a few years using TMS you can think of removing . '
historical data and items that have been missing, discarded Dglete history EI
or damaged for so long. With File>Delete history you Non operational tppes

activate the Delete history screen that enables you to delete v Histar [lag)

the TMS history and non-operational items older than a [v Damaged itemsz

given date. The data to be deleted has to be at least from [~ ltems under inspection

the previous year or older. You can enable or disable each v Miszing items

type by clicking its checkbox. Serialized issued items will [ Items in repair

never be deleted; TMS presumes these to be indefinite v Dizcarded items

lends. Use this procedure every 5 years or so. [ lzsued items

ADVICE: Only delete history and non-operational items
because the data isn't relevant anymore. You
don’t have to cleanup for performance or disk Delete! | Cancel

space reasons.

Data older thar: | ] /1 /42000 =) 1)-3) .5

3.6 Moving around item screens

3.6.1 Find items... function

When you want to find an item regardless if it is lend,
issued or on stock you can use the Edit>Find item(s)...
function (or press {control-F} on your keyboard). In this

Find itemi{s)

Search for; |Descripti0n [Dj |bool 0.5 mm

Froductzode
| Campanytlr

Searchtext length: 11 [88 chars left).

window you can search for items based on its productcode, companynumber, description or
searchcode(s). You can type in a part of or several parts of the code or description. It will find

items in stock when lend, issued or non

Search for: |Descripti0n [oﬂ |b00l 0,5 mm|
- - - - OPERATIOMAL ITEMS - - - - ~
80000003 - Boor Metaal- 0.5 Mm. - 57 mwred by Brand R. (000001)

80000003 - Boor Metaal- 0.5 Mm. - 3 owned by Hogenbirk J. (000012)

80000003 - Boor Metaal 0.5Mm. - 4 owned by Stam J. [Q00002]

80000003 - Boor ketaal- 0.5 Mm. - 3 owned by Swenz R, (000003]

80000103 - Boor Metaal- 105 Mm. - 21 owned by Magazin (STOCK)

80000212 - Boor Metaal-Conische Schacht, 105 Mm. - 17 owned by Magazin [STOCK)
20000239 - Boor Metaal-Conische Schacht, 205 Mm. - 2 owned by Magazin (STOCK]
80000263 - Boor Metaal-Conische Schacht, 305 Mm. - 4 owned by Magazin (STOCK)

-+ - - ITEMS IN CLUSTERS - - - -

20000003 - Boor Metaal- 0.5 Mm. - 2in cluster 80951 760:- - Hamas  wWhi17EOVg

80000003 - Boor Metaal- 0.5 Mm. - 3in cluster 80951760:12346 - Hamas  'Wh7E0Vg
80000003 - Boor ketaal- 0.5 Mm. - 1 in cluster 830351760 WHT7EVG - Hamas  Whi760Vg
20000003 - Boor Metaal- 0.5 Mm. - 5 in cluster 80951 765 WHTVEEVG - Hamas  Whi7EBYg
-+ - - NOM-OPERATIOMAL ITEMS - - - -

80000003 - Boor Metaal- 0.5Mm. - 1 marked az issued since 23/09/2004 17:24

20000003 - Boor Metaal- 0.5 km. - 10 marked az under ingpection since 0840342004 17:53
80000003 - Boor Metaal- 0.5 Mm. - 2 marked as under inspection since 14/08/2002 10:50
80000003 - Boor ketaal- 0.5 Mm. - 16 marked as damaged since 28/04/1335 00:00
20000003 - Boor Metaal- 0.5 Mm. - 1 marked as under inspection since 10/07/2001 11:09
AANANNNTT - P biatsal N B kA - 1 markad ar ondar isenaction winea 14 052000 0872
Found: 26

operational (damaged etc..) and in
clusters (whatever status). With a click on
[Find] you get a list of items that match
your search criteria. When you double
click on a line, TMS will activate the
appropriate screen and jump to the item
selected. If it turns out that you selected
the wrong item select Find items... again
and repeat the search (you last search has
been kept) or select the [others] button
or menu (right click on a line).
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3.6.2 Others button or sub-menu choice

In most item screens like the Stock overview there is an [others] Mdr“!ﬂmhers button. When
you click on this button (or select Others on the item sub-menu (right click on
a line)) al History complete list of all the items with the product code of the item you
selected m is shown. If you double click on an item in this list you will jump to that
particular IEt':'n::;Z'c"ks entry in TMS. The Others function is also available in the product
overview screen (Edit>Products) but is called the [Items] button there.

3.6.3 Go from cluster content

to cluster entry itself
When you use the Find items... or ﬁHemuve ® |!U|||Earc:ude g? Damaged é Inzpect @Mmlnc

Others function you might end up
within a cluster content screen. If Product ||:gmpan_|,|N[ | ﬂ_l Dezcription | "-.-"aluel
you want to manipUIate the cluster 80301002 HGI10025T 1 Staalstrop, 1 kb Swl 1200kKg  Hgl0025t  £15.70
itself you must go up one level to A0901006 HG100B5T 1 Staalstrop, 1 Mir. Swl 1200Kg  HglOOBSt  £15.70
20901002 HGTO0025T 1 Staalstrop, 1 Mir. Swil. 1200 Kg  Hgl0025¢t
1
1

the entry of the cluster in the | spamp7 Heioizer Staalstrn:up 2 M. § Hal0175t
stock, lendings etc... overview. You WH1739 Harnas whi

do so by double clicking on the

Registered to... text in the Feaistered tao Magazijn - STOCK Total: | 5 £201.00
St.atUSbar of the cluster contents Doubleclick to goto cluster ak STOCK
window.

3.6.4 Items per storage location

The Items per storage location screen shows items grouped by storage location but
regardless of their status (either lend, issued, non-operational or in stock). By using the
[Other] button you can quickly switch to the screen that actually contains the item. You can
use this screen also to print multiple barcode labels by marking the checkboxes and click on
[print barcode(s)].

3.7 Manipulate items manually

TMS lets you lend, issue and return items using barcode readers. Most of the work will be done
with the readers but you can of course also perform these actions with the TMS PC software.
This will allow you to correct problems, mark items as damaged, missing and so on and
compose clusters. In general you can use drag and drop to drag an item from one window to
another. Furthermore you can use the [Damaged], [Inspect], [Missing], [Repair] and
[Discard] buttons to mark an item as such instantly (where available).

ADVICE: Use a screen resolution of 1024x768 and a 17” monitor so that you have enough
room for drag and drop actions.

3.7.1 Lend and return

Open both Stock and Lending overviews and select a person in the Employee list on the left of
the Lending overview. If you have not selected an employee in the left panel ((all) is selected)
then the tool will be lend to the person who owns the selected tool in the item listview (the
right panel). From the Stock overview select the tool you want to lend and drag it to the item
listview from the Lending overview. TMS will ask you to confirm that you want to move the
item selected to the person selected; click [ok]. If the item is non-serialized and there is more
than one available then you will be able to change the number of items to lend. To return an
item you can either drag and drop it back to stock or click on the [Return] button on the
toolbar.

3.7.2 Issue and return

Open both Stock and Issued items overviews and drag and drop items from the Stock window
to the Issued items window (similar to 3.7.1; Lend and return).
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3.7.3 Mark item as damaged, inspect, missing, repair or discard

Use the [Damaged], [Inspect], [Missing], [Repair] and [Discard] buttons to mark an
item as such instantly from the Stock, lending, non-operational items and cluster overviews.
Note that these buttons are not available in the Issued items overview. Because the jssue
action is mainly intended for consumables, marking these items as damaged and so on isn‘t
meaningful for non-serialized items. You can however drag and drop serialized items that have
been issued to a non-operational section in the non-operational items overview and it will be
moved to that part (after confirmation).

The report Inactive items per department (Report>Item actuals>Inactive items per
department) will show you all the damaged, missing, discarded etc... items grouped by
department for a given period of time.

3.7.4 Return non-operational items back to operation.

From the non-operational items overview click on the [return] button or drag and drop it onto
the Stock overview’s item listview. When you use the [return] button and the item originated
from a cluster or an issued item screen TMS will offer you to return it to either the original
cluster/issue owner or to stock. This will limit your effort to return inspected items to a cluster
or issued owner (indefinite lend). This way there is no need to move the item from stock to the
cluster or the issued owner again.

3.7.5 Create and compose a cluster.

Create a cluster item by using an existing product definition that is a cluster or create a
product definition with a cluster marking as described under chapter 3.3 ‘Add a new tool’. Find
the cluster in the stock overview (you can recognize them by the toolbox icon) and click on the
[cluster] button (or right click and select cluster). A new window opens showing the cluster
content (this will initially be empty). You can add items to the cluster by dragging items from
stock into the cluster content window. You may also move items from one cluster content
window to another or even from the /ending overview into a cluster.

3.7.6 Other item movements.

Apart from the item movements described above you can also move items:
e From the /ending overview to the issued items overview. This will be handled first as a
return to stock action and secondly an issue action and will be logged accordingly.
e From the jssued items overview to the lending overview. This will be handled as a
return to stock and then as /end action and logged accordingly.

3.8 Manage the purchase list

By using the minimum stock field in product definitions you can set your minimum stock for
each product type individually. TMS uses these minimum stock values to determine for which
items the number of items have fallen below stock minimum in the ‘List of products to be
ordered’ report (Report>Orderlist). If you set it to zero then the product will not appear on
the order list.

Tool Manageme i to@®m 207 35 0k TP Lt

Cbject Software Ontwikkeling BY a/4j200518:58
List of products to be ordered

Productcode Description Stock calculstion tem calculation
00000035 Boar Metaal- 0.5 Mm. Stock: 1] Total: B7
Supplier: 1 “an Eyle & Ruygers Stock minimurm: a3 99
Contact: Cortenberghe, Yan C. Phone; 010-2455014 To be ordered: 99 32
0000005 Boor Metaal- 1 Mm. Stock: 15 Total: 15
Supplier: 1 “an Eyle & Ruygers Stock minimurm: a8 =8
Contact: Cortenberghe, Yan ©. Phone: 010-2455014 To he ordered: “ M

This list will show you two calculations of the amount to be ordered: first is a calculation of the
minimum level minus the number on stock. The second calculation is the minimum on stock
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minus the total number of items on stock and lend. You can judge yourself how many items
you must order to get to the optimal stock level again.

3.9 Manage checks and inspections

For each product you can set a number of days between inspections or checks an item needs
(Edit>Products, Edit product, field Inspection interval and Check interval). Although the
interval for each item of a product is the same, the actual inspection/check due date is
determined for each item individually (serialized items only). This

inspection/ check due date of an item is either the deployment UG RN R X]

date or the last inspection/check date of the item plus the number Selection

. . " Diue now
of days under Inspection/check interval of the product. When & \Within the nest 7 daps

set to zero no periodic inspection/check is required. In general the i s s 20 ke

interval between checks will be less than the interval between " Custom Days

inspections (see chapter 2.6 Item inspections and checks).

ar. | Lancel ‘
To see for which items the inspection/check date will be or already
is due, use the reports Items to be inspected and Items to be checked (Reports>Items to be
inspected/checked).
The report History of inspected items (Report2>Item history>Inspected) shows which items
have been inspected (or are still under inspection) in a given period of time.
The report Item checks (Report>Item actuals>Item checks) shows you all checks carried
out in a given period of time.

3.10 Solving item bag processing errors

As explained in chapter 2.8, the item bag contains unprocessed or incorrect transactions from
the barcode readers. Transaction are downloaded with a click on the [Retrieve transactions]
button (then click [Transfer]) in the toolbar. After download these records will appear under
the section Barcode reader on the right of the item bag screen. The [Process] button will
process the pending transactions into the administration. With the [Discard] button you can
remove a transaction from the item bag; it will not be processed.

& ltembag - Items imported from barcode readers g@@
W& Retrieve transactions (3 Process M Discard | <2 History 8% Others
Wiew | Date | Product | Compa... | D escription | #.l Action | Sender | Mame [5] | Receiver | Mame [FA] | Status | -
2004-05-10 09:2303 6547000 Kitpistaol 1 Lend STOCK 4 agaziin 00863001 Majoor, E pending...
2004-05-10 09:23:08 £350015 “erst. moersleutel 18" L=450rmm 1 Lend  STOCK 1 agaziin 00863001 Majoar, E pending...
% 2004-05-1010:22:22 73C0MAL 7300105 Laptap 1 Lend STOCK 4 agazijn 00861856 Plantinga, M.P. warning; deactivated emp...
2004-05-10 10:47:13 B368307  211.238  Momentsleutel 8-40 Mm 348" 1 Lend  STOCK td agazijn 00333754 Sawal, PS5 pending.
2004-05-1010:47:16 6368301 2.11.240  Momentsleutel voor 1/2" 1 Lend STOCK 4 agaziin 00933754 Sawal P.5. pending...
2004-05-1010:51:24 B365848 08CO117  Slagmoersleutel 1" pneumatisch 1 Lend STOCK I agaziin 00861773 Muntiewerfl, R.G.T.  pending...
2004-05-10 10:52:09 B3E3636 Sleuteldop 2eskant 36mm [1"] L=87rarm 1 Lend  STOCK 1 agaziin 00861773 Muntiewerfl, R.G.T.  pending...
2004-05-10 10:52:57 B354565 Ringsteeksleutel 36mm 1 Lend  STOCK 4 agaziin 00861773 Muntiewerfl, R.G.T.  pending...
@ 2004-05-10 10:54:21 B350015 Werst. moersleutel 18" L=450mm 1 Retun 00863001 Majoor, E STOCK tagazijn pending.
2004-05-10 10:54:27 6547000 Kitpiztool 1 Retun 00863001  Majoor. E. STOCE, tagaziin pending...
2004-05-10 10:54:46 B3E8528 08CM27  Slagmoersleutel 1/2" pneumatizch 1 Lend STOCK I agaziin 00862883 Rooy, de, D. pending...
2004-05-10 10:54:54 6368528 08CM30  Slagmoersleutel 1/2" preumatisch 1 Lend STOCK 4 agaziin 00862888 Rooy, de, D. pending...
2004-05-10 11:00:40 FAC0102 Megger woor ractiematoren en hoogspanning... 1 Lend  STOCK 4 agaziin O0E72527  Ushi, M. pending. .
2004-05-1011:01:04 5259062 1BCON02  Boormachine 156, acou Metabo BST15.6.. 1 Lend  STOCK 4 agazijn 00B90271  Mese, M. pending...
2004-05-1011:08:46 73C0NAL 73CO105 Laptop 1 FRetun 00361856  Plantinga, M.P. STOCK Maagaziin warning; deactivated emp.._
& 2004-05-1011:05%:11 01Co112 Steeksleutel voor stoot en trekwerk 1 Lend STOCK 4 agaziin 00863001 Majoor, E pending...
2004-05-1011:09:31 6368864 08CON35  Slagmoersleutel 1" preumatisch rechte vity. 1 Lend STOCK 4 agaziin 00863001 Majoor, E pending...
2004-05-1011:09:45  0BC0104 Luchtzlang & bar 1 Lend  STOCK 1 agaziin 00863001 Majoar, E pending...
2004-05-1011:09:57 B362550 Sleuteldop bwaalfkant S0mm [1') L=78mm 1 Lend STOCK 4 agazijn 00863001 Majoor, E pending...
2004-05-1011:10:14  BA16978 Opsteekizer D=25mm, L=710mm 1 Lend STOCK 4 agazijn 00863001 Majoor, E pending.
2004-05-10 11:10:47 F1CO102 tegger voor tractiemotoren en hoogspanning... 1 Fetun 00672527 Uslu, M. STOCE, tdagaziin pending...
2004-05-1011:18:00 6345022 Zaag, ijzer hand zaagblad L=300mm 24 tande... 1 Lend  STOCK I agaziin 00553523 Croonen, B.G.A. pending. .
2004-05-1011:24:41 B345022 Zaag, ijzer hand zaagblad L=300mm 24 tande.. 1 Retun 00553529 Croonen, B.G.A.  STOCK Magazijn ending...
2004-05-10 1 F188014 il basterd platstomp L=350mm 1 Lend STOCK b4 aazij 00553529 Croonen, B.G.A. ing...
20 -10 COTAC 9500102 devren 2 1 Le =nburg. & H - deactivated emp.___
AR M aatmal rositis daor ko w kakused IR 1 land  STOCK [T MNAIFRAL A sedanbirn A H warmina- dasctuatad amn
Barcode [46) | 1= "95C01ALC:95C0102' fram Magaziin [STOCK) to Aardenburg, & H. [00933598]
Chapter Quick reference guide page 17/22

© 1999...2005 Object Software Ontwikkeling BV Version 12/4/2005 rev

.53




TMS getting started and quick reference guide

= N

X

3.10.1 Itembag sections
Besides a toolbar this screen is also divided into sections:

3.10.1.1 Manually added

Al | movements of items, including drag and drop actions within TMS, are in fact handled via
the itembag. If you want that manual actions are not immediately and automatically processed
deselect the checkmark under File>Configuration, Process manual actions immediately.
When disabled your manual actions will be treated equally and in order of date/time as
barcode reader transactions and such manual transaction will appear in the section Manually
added in the itembag. It is however recommended not to deactivate this option.

3.10.1.2 Barcode reader

This section contains all transactions downloaded (transferred) from the barcode readers.
When item(s) are lend to a person who is deactivated you are warned. If you do not discard
this transaction the item(s) will be processed. After all, the item(s) have been lent to this
person or whoever who has that employee code...

3.10.1.3 Processing errors
Transactions can be marked as erroneous in two ways:

1. During download; when data of a transaction is apparently flawed and processing of it
will fail, it is marked erroneous immediately and moved to processing errors even
when the transactions have not been processed yet.

2. After processing; if there was any kind of inconsistency or error during the processing
of a transaction it will be marked erroneous.

3.10.1.4 Blanks

When more parts of the transaction are left out or are invalid then it might not be possible to
process the transaction at all, even after correction. The blanks section shows probable
garbage transactions that can be deleted immediately. For example: if someone enters ‘1’ on
all scan requests of the barcode reader this line will be stored and transferred but shown on
the blanks page so it can easily be removed.

3.10.2 Order of actions

The proper order of actions to take when you want to incorporate barcode reader transactions
into TMS:

1. Retrieve transactions

2. Eliminate blanks (optional)

3. Process transactions

4, Deal with processing errors

3.10.3 Deal with processing errors

Processing errors can occur because of various reasons. When a conflict occurs or some data is
missing in a transaction TMS will not process that transaction but mark it with an error.

For instance: someone lends 5 screwdrivers 15mm and this is scanned with the barcode reader
but TMS has only registered 4 on stock. Since the barcode reader works off-line it doesn't
know the administrative stock. If there are actually 5 screwdrivers on stock you will notice the
discrepancy only when you process this transaction.

Another example: someone lends 1 wrench and returns a screwdriver. The warehouse however
scans both tools with ‘return item’. During process TMS will show the error that the person
cannot return the wrench (he has actually lent it) because he never owned it.

It has been stated before: the better the desk personnel works with the barcode readers the
less processing errors there are to deal with. Nevertheless there will be processing errors since
mistakes can always happen and the TMS administration can (and probably will to some
extent) deviate from reality.

To solve these problems it is best to go through each error chronologically starting with the
oldest transaction. When you click on the erroneous transaction you can see the error
description in the status bar and in the Status column. If the employee- or product code or
company number is invalid it will be coloured red. A right mouse click on the transaction shows
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you the options you have to handle the error. These options are context related and while
some options are available for one problem they might not be for other types of problems.

3.10.3.1 Discard transaction (always available).
This will delete the transaction from the list. It is like the transaction never
happened and thus it will not be processed. Use this when other options fail.

3.10.3.2 Change to>Issued/Lend/Return (always available)
Switch to a different transaction type. In case of the previous example where you
know that someone has lent a tool in stead of returned it you can correct it.

3.10.3.3 Retry (always available).
Always try this option first (a double click also triggers this option). It might be that
the error is caused by another problem earlier on and that it has been solved
already. In case of the example where someone has lent a tool but it has been
registered as a return: this might be the transaction where he really returns it.
Since the previous problem has been corrected using Change to lend this line is now
correct. A retry will now process the transaction without problem.

3.10.3.4 Log and discard (context sensitive).
In TMS version 1.xx a string of problems could occur such as described above. In
version 2.xx an erroneous transaction of an item will also no longer ‘block’ correct
transactions from a later date. This might lead to the error ‘transaction is older than
the current assignment’. In that case you can either discard or log and discard it.
With the last option the transaction will only be registered in the log but not be
processed.

3.10.3.5 Process max. possible (context sensitive).
This option will be available when for instance more items are lend or returned than
the owner has. Say 5 items are lent to person X but only 4 are registered on stock
within TMS. With Process max. possible you will only lend those 4 that are on stock.

3.10.3.6 Force transaction (context sensitive).
This option will be available when for instance more items are lend or returned than
the owner has. Say 5 items are lent to person X but only 4 are registered on stock
within TMS. With Force transaction you will lend 5 items (and increase the total
number of items of that product).

3.10.3.7 Keep with sender or keep with receiver (context sensitive).
These options will be shown when an item appears to have 2 owners. A choice for
one removes all other registrations of the item.

3.10.3.8 Suggest solution (context sensitive).
When an employee code, product code or company number is missing or incomplete
or a code has been scanned in the wrong section TMS provides you the suggest
solution option. TMS will try to resolve missing or misplaced data automatically but
human help is often needed to make the right choice. You can select the right tool
or employee from a list of codes that match the faulty code in the transaction.

Use the [other] and [history] buttons to figure out where a tool currently is or what has
happened. You can also use the Manage screens to correct problems or to do the transaction
manually.
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4 Usmg the TMS barcode reader

The barcode reader used for TMS is a kind of handheld
computer with its own CPU, memory, display3 and
keyboard?. It can operate completely autonomously
because it runs its own software and stores information in
its own internal memory. This means that you are not
attached to wires and thus limited to the length of a wire
nor will you have any interference or dead spots on your
site as with wireless RF-solutions often is the case
(especially in tool rooms with a lot of steel). A drawback
of an independent system like this is that it isnt directly
connected to the central TMS database. It is therefore not
aware of mistakes you make and changes made by other
barcode readers.

® clock

@ battery status

® display

@ back button

The reader has several keys but not all of them are active

® activate/scan because they are not needed for TMS.

4.1 Parts of the barcode reader

® toggle numeric/

alphanumeric 1. Internal clock; all transactions get a date and

time stamp so they can be processed correctly
by TMS. The time is synchronized with the PC
clock every time data is transferred to TMS (if
the difference is more than 10 seconds).

2. Battery status symbol; if the symbol is empty,
so is the battery. The battery is recharged when
it is the communication/charging cradle.

3. LCD display with 4 lines of 16 characters; use
{shift €} to toggle the backlight, {shift >} to
cycle through 15 steps of contrast settings.

4, arrow keys; with the TMS application only the &
key is enabled. It acts like the ‘back’ key in a
web browser and always takes you one step back.

5. activate/scan; turn on the barcode reader or scan a barcode with this key. The
barcode reader automatically shuts down after 15 seconds of inactivity. When you
press {scan} you will always return to the state the barcode reader was in when it
shut down.

6. shift key; this will toggle between numeric and alphanumeric digits input when the
keyboard’ is used.

7. keyboard; enter numbers (default) or characters using the {shift} key.

8. Enter key; press {enter} to confirm an entry or choice.

9. backspace key; use {backspace} to delete the previously typed character.

@ keyboard

confirm entry

©® backspace
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4.2 TMS barcode application

The TMS barcode reader application starts with a main menu. It the reader is not in the main
menu press the {<} several times until you are in this menu. The main menu:

. Lend

| ssue

Ret urn

St at us

PN PE

You can select the action you want to do by pressing key 1 to 4 and press {enter}. The reader

will now show the selected action and requests the employeecode. For instance:
Lend
Enpl oyee?

Scan or type in the employeecode; you will hear a short beep. Now TMS requests the

productcode of the tool:
Lend
123
Pr oduct code?

Scan the productcode on the barcodelabel of the tool (you may also use the keypad). When it
is a serialized tool and this code is unigue (marked with a $ sign) you can scan the
companynumber at this point. The scanner will store and request a new tool immediately.
When a productcode is scanned the barcode reader will ask for either the number of items or

the companynumber.
Lend

123
5320139
#?

Now enter the number of items you will lend if the product is not serialized. For instance: type
in 3 and press {enter}. If the product is serialized you scan the second barcode on the label
(the one on the right). When you have scanned or typed in this last code or number of items
two beeps of increasing pitch will be heard indicating that the tool is now stored as lend. Note
that with the return function the two tones have a decreasing pitch. The barcode reader will
request another product code to lend for this same person. You can continue to lend tools to
this person until you are done.

When you need to lend a tool to a different person press {<3} until the barcode reader

requests a new employeecode. When you want select a different action press {<7} until you
are in the main menu again and select the new action.

4.2.1 Schematic overview of the TMS barcode application

Main menu < key
Lend/Issue/Return :
» | Action
Emplovee? < key
Productcode?
#?
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4.2.2 Return exception

The menu options Lend, Issue and Return all operate in the same way. The only exception is
the return of unique serialized items. When such an item is scanned on the Employee?
request it will store and loop immediately because TMS can determine the owner from the
database.

4.2.3 Barcode reader status

This menu option will show how may records (transactions) are stored in memory and how
much memory is still free (in percent). Use the {<} key to return to the main menu.

Chapter Using the TMS barcode reader page 22/22
© 1999...2005 Object Software Ontwikkeling BV Version 12/4/2005 rev.53



	Software and manual written by:R.M. de MareObject Software Ontwikkeling BVMolenstraat 8ANL 2242 HT WassenaarT +31 (070) 517 72 86F +31 (070) 517 64 18( mail@objectso.nl
	Introduction
	Purpose of this document
	Conventions and terms used in this document

	TMS definitions and methods
	Common tables
	Products and Items
	Serialized and non-serialized items
	Clusters
	Operational and non-operational items
	Item inspections and checks
	Issued items
	TMS itembag
	TMS log
	Barcodes

	Quick reference guide
	Quick explanation of TMS controls
	Common program controls
	Reports
	Listviews
	Window menu
	Help(Support(e-mail Support Request

	Employee actions
	Add an employee
	Delete or deactivate an employee
	Renumber/rename an employee

	Add a new tool
	Using an existing product definition
	Using a new product definition

	Remove a tool
	Remove historical data and non operational items
	Moving around item screens
	Find items… function
	Others button or sub-menu choice
	Go from cluster content to cluster entry itself
	Items per storage location

	Manipulate items manually
	Lend and return
	Issue and return
	Mark item as damaged, inspect, missing, repair or discard
	Return non-operational items back to operation.
	Create and compose a cluster.
	Other item movements.

	Manage the purchase list
	Manage checks and inspections
	Solving item bag processing errors
	Itembag sections
	Manually added
	Barcode reader
	Processing errors
	Blanks

	Order of actions
	Deal with processing errors
	Discard transaction (always available).
	Change to(Issued/Lend/Return (always available)
	Retry (always available).
	Log and discard (context sensitive).
	Process max. possible (context sensitive).
	Force transaction (context sensitive).
	Keep with sender or keep with receiver (context sensitive).
	Suggest solution (context sensitive).



	Using the TMS barcode reader
	Parts of the barcode reader
	TMS barcode application
	Schematic overview of the TMS barcode application
	Return exception
	Barcode reader status



